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Overview

Introduction

Welcome to the User’s Guide for the Demonstration Version of ToolTime.
This document will assist you in getting started and previewing the many
useful features available in the full version of ToolTime.

The Demonstration Version of ToolTime allows you to enter a limited
amount of information, with restrictions on the number of records allowed in
all tables.  The security system in the demonstration version is entirely
active, so you can alter those settings (with a limited number of authorization
codes.)  Though this printed guide is a smaller version of the full system
documentation, the demonstration version does contain the text of the full
manual as an online help system.

What is ToolTime...?

Welcome to ToolTime, a Windows-based, computerized maintenance
management system from Dixon Creek Software.  Over 17 years of
experience in developing and enhancing facility information management
software for clients around the world has gone into the making of this
package.  ToolTime is the result of our goal to help our clients maintain their
facilities efficiently and affordably.  It offers affordable maintenance cost
tracking and reporting features that can efficiently maintain virtually any
equipment or facility.
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We have all heard it:  Keep costs down… increase productivity… decrease
equipment downtime…  Unfortunately, it's not easy accomplishing these
objectives while managing a facility day-to-day.  There is good news,
however.  ToolTime can help you track costs and other valuable
information related to any equipment maintenance.

Unlike most maintenance management programs, ToolTime allows creation
and editing of corrective, or unscheduled work orders from a single screen.
No paging through screen after screen to create, edit or close a work order.
ToolTime's point-and-click interface makes it easy to enter information
anywhere on the screen.  And with customized security levels available to
individual users, the possibility of unauthorized access to maintenance data
is minimal.

It is no secret that the key to any successful maintenance program is
preventive maintenance (PM).  Scheduling and performing PM tasks as
recommended by the manufacturer will not only keep equipment operating
at its peak, but will, in many cases, sustain the manufacturer's warranty.
ToolTime allows easy scheduling, updating and tracking of an unlimited
number of pre-defined PM tasks that you create!  Groups of completed
PM tasks can be updated simultaneously with ToolTime's PM Search
Closure capability.

Every equipment item has specific information associated with it.  For
example, a motor has nameplate information such as horsepower, voltage,
and serial number, while a manhole has size, depth and elevation
information.  ToolTime comes with 30 easy to edit, pre-defined nameplates
for popular equipment items such as motors, pumps, and boilers.  And you
don't have to settle for inadequate equipment information forms – you can
design a custom nameplate yourself for any piece of equipment.

ToolTime allows for tracking of parts inventory location, ID number, cost
and audit trails.  Parts availability and checkout are automatically performed
at the work order level.  Parts can even be assigned to individual employees
as well as by work order.  If a part is not used during repair of equipment, it
can easily be re-stocked and accounted for in the system.  ToolTime makes
handling parts a snap.
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ToolTime comes with over 70 pre-designed reports, plus a menu selection
to optionally launch custom reports.  With your choice of many popular
custom report generators, you can customize reports for any type of data in
ToolTime.

ToolTime provides some of the most flexible and powerful sorting and
filtering capabilities available.  Virtually any information can be sorted and
filtered by any combination of ID number, location, ID pattern (including
wild cards), work order title phrase, craft code, text search phrase, priority,
date range and three user-defined fields.

Because ToolTime operates in the Microsoft Windows environment, all the
popular graphics interface features can be used such as cut, copy, and
paste.  And since ToolTime uses Microsoft Access as its database, getting
the maintenance information is simple with the many popular Windows
database manipulation programs and report writers.

Dixon Creek Software

Who Are We

Dixon Creek Software is a small company focused on the needs of the
individual client.  Specializing in full-service PC-based computer application
development, Dixon Creek Software provides assistance in not only
application construction, but also systems analysis, installation and support.
Our goal is to produce software that suits our client’s needs.  We want our
clients to be satisfied with the software well after final delivery.  End-user
support is very important at Dixon Creek Software, and we make every
attempt to see that our clients are as happy as possible.
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Getting Started

Getting Started Overview

This section of the guide will help get you started in using ToolTime.  It
describes the procedures and requirements for installing the software, along
with step-by-step for initial configuration and setup.

Installing ToolTime

ToolTime requires the following hardware and software:

• Windows 3.1 or higher, Windows 9x or Windows NT

• 386 or higher (486 recommended)

• 8MB RAM (12MB recommended)

• 15MB hard disk space

Important Note:  Make sure that no other Windows programs are
running or minimized when you start the ToolTime Setup program.  If
you use a virus protection program on your computer, override it or
turn it off before you run Setup.  Setup may not run properly with
these programs also running.  Once ToolTime has been installed and is
working properly, these programs can be reactivated.
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To Install ToolTime with Windows 3.1

1. Start Microsoft Windows.  Make sure that the Windows
Program Manager is active.

2. Close all applications running in Windows.

3. Insert the ToolTime Demo CD into Drive D.  Note: These
instructions assume your CD-ROM is drive D.  If it is not,
replace the d: in all following instructions with the
appropriate drive letter.

4. From the File menu in the Program Manager, select Run.

5. Type d:\setup.exe and click OK.  You can also select
setup.exe on the d:\ drive by clicking the Browse button.

6. Follow the Setup instructions on the screen.  ToolTime should
take just a few minutes to install.

To Install ToolTime with Windows 95/98

1. Start Microsoft Windows 95/98.

2. Close all applications running in Windows 95/98.

7. Insert the ToolTime Demo CD into Drive D.  Note: These
instructions assume your CD-ROM is drive D.  If it is not,
replace the d: in all following instructions with the
appropriate drive letter.

3. Select Start from the Task Bar and then select Run.
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4. Type d:\setup.exe and click OK.  You can also select
setup.exe on the d:\ drive by clicking the Browse button.

5. Follow the Setup instructions on the screen.  ToolTime should
take just a few minutes to install.

Once ToolTime has been installed, a Dixon Creek Software program group
will be created in Windows Program Manager containing the standard
ToolTime startup icon.  The standard icon can be replaced with any icon
you choose.  However, when minimized, the standard ToolTime icon will be
displayed on the Windows desktop.  You can move the ToolTime startup
icon from the Dixon Creek Software group to any group you like.  You can
even make multiple copies of the icon and start the program from several
different program groups.

Setting Up ToolTime
There are a variety of tasks which need to be performed when you first use
ToolTime to ensure that everything will function properly.  Pay close
attention to the steps and instructions listed in this section, because they will
make certain that ToolTime is fully prepared for use.

To Start ToolTime

1. Open the program group in which you installed ToolTime.  (The
default program group created by Setup is named Dixon Creek
Software.  You can create and name your own program group
if you wish.)

2. Double-click on the ToolTime program icon.  ToolTime should
start.
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If you are starting ToolTime from a network file server, the program group
icon must point to the path on the file server containing the program
executable TOOLTIME.EXE.  An example is shown below:

M:\SOFTWARE\TOOLTIME\TOOLTIME.EXE

When ToolTime starts, it opens the default database file
TOOLTIME.MDB.  This Microsoft Access database file is fully structured
and configured, but does not contain any data.  You must begin entering
information to build, or populate, the database.  The following section
describes recommended methods for populating a new database.

Populating a New Database

Before you begin using ToolTime, you will need to populate the database.
This means entering equipment and other maintenance data so that you can
begin scheduling maintenance and generating reports.

Populating the database can be a very time consuming process if not
executed in an orderly and reasonable fashion.  Therefore, care should be
taken in collecting and entering information into the database.  ToolTime
relies on a wide variety of information types in order to properly schedule
and report maintenance information.  We recommend that you populate the
database in a particular order.  Doing so will facilitate the entry of remaining
data and will familiarize the users with the new program.  It is recommended
that data be entered into a new database in the following order:

1. Craft Codes

Craft codes in ToolTime are used as a general description of an employee,
PM procedures or work order work completed.  This lets you see at a
glance what type of work an employee does, or what sort of employee is
needed to perform the PM task.  Many ToolTime reports allow you to
restrict report output by craft code.
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2. Suppliers

Suppliers are businesses which you purchase your parts inventory from.
These need to be entered before your inventory and other information is
entered, so that suppliers can be assigned to those items.

3. Tools

Tools within ToolTime can be assigned to various tasks and items.  These
need to be entered before  making equipment and/or inventory items so that
they can be assigned to the appropriate places.

4. Locations

Location codes within ToolTime allow the physical location of an equipment
or inventory item to be tracked within the program.  This also allows that
information to be stored independent of the item’s other data, so if the item
moves only the location code has to change.

5. Manufacturers

Manufacturers are companies that make equipment or sub-component
items.  This information needs to be entered so that it can be assigned to the
right items in ToolTime.

6. Employees

Employees are the people that work in your facility.  ToolTime allows you
to track their pay, work schedule and task assignments.

7. Parts Inventory

Parts inventory is used in the maintenance (corrective and/or preventative)
of equipment items.  These parts can be assigned to employees working on
tasks or listed with specific tasks or equipment items.  ToolTime also
provides facilities for performing blind audit counts as well as budget
number tracking.  ToolTime automatically deducts parts from inventory
when issued to corrective or preventative maintenance work orders.
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8. Preventive Maintenance Procedures

Preventive Maintenance Procedures are the PM tasks that your equipment
need.  PM procedures can be assigned to any number of equipment items
(in the full ToolTime system) and store the general information about a PM
task.

9. Equipment Information

Equipment information includes location, inventory assignments, and
nameplate data, which can be tailored to your individual equipment needs.
Also equipment items track their current mileage, time in use, etc. for use in
PM maintenance.

Numbering Systems

Another important step in preparing ToolTime for use is the development of
a numbering system.  To be able to use ToolTime's features, you must come
up with a numbering system for your equipment, equipment locations,
preventive maintenance procedures, and parts inventory.  Because
ToolTime is a computer-based maintenance management system, it requires
a tracking index method.  Unique equipment numbers provide a means by
which ToolTime can accurately relate and track all information regarding an
equipment item.  Therefore, the equipment ID number is the key
alphanumeric number that ToolTime uses to track all work order
information.

While numbering systems can be somewhat arbitrary, they should be
logical, expandable, and provide the user with a quick visual reference as to
the identity of the equipment item.  For example, using a leading character
"P" for pumps, or "M" for motors provides an instant clue to the system user
as to the type of equipment.  Following are some tips in developing your
numbering systems:

• Try to use all of the character spaces available in each number.
For example, if the system allows 10 characters for an
equipment ID number, use all 10 characters.  Use leading zeros
or other characters if necessary.  This will provide for uniform
number lengths and easier view of reports and other printed
maintenance information.
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• Avoid using unnecessary characters such as dashes, spaces and
asterisks.  They limit your usable field character length and
provide little or no usefulness from a numbering perspective.

• Avoid embedding a location code in an equipment ID number.
ToolTime allows the creation and assignment of separate
location ID numbers.  ToolTime uses the equipment ID number
to track information for an equipment item.  If you embed a
location code and later relocate the equipment, a new
equipment ID number must be assigned, thereby disassociating
the work history for that equipment item.

• Embedding equipment type categories within numbers can be
helpful.  It will aid users in quickly identifying the equipment.
For example, you could lead all centrifugal pumps with "P100."
The "P" designates "pump," while "100" designates a "centrifugal
pump."

Using Patterns and Wildcards in ToolTime
ToolTime frequently allows you to search for specific information based on
criteria that you set.  These places include all report selection screens, PM,
CM and purchase order searches.  Many of these screens will include a
pattern box, or another area where wildcards may be used.

Patterns can be the exact text of a desired ID or a mixture of text and
wildcard characters.  Wildcards consist of the question mark (?) and the
asterisk (*).  A question mark can stand in the place of any single character
in the ID.  Thus, if you wanted to search for all IDs with the first three
characters matching "123" and the final one being anything, you would type
the pattern:

Pattern: 123?

IDs such as 1234, 1230 and 123A will be found by the above pattern.

The asterisk finds any characters and any number of characters.  Thus, if
you wanted all IDs which begin with 1, you would enter:
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Pattern: 1*

In the given case, IDs such as 15, 1AD and 1234 would all be shown.  Any
combination of wildcards and allowed characters may be used.
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Technical Specifications

System Requirements
• Windows 3.1 or higher, Windows 9x or Windows NT

• 386 or higher (486 recommended)

• 8MB RAM (12MB recommended)

• 15MB hard disk space

Networks:  ToolTime has been thoroughly tested using Novell v3.12, but
should also work with the following network operating systems:

• Windows for Workgroups 3.11

• Windows 9X or NT network

• Novell v3.x, v4.x

• LANtastic peer-to-peer network

Regular backups of your critical data is essential.  Although ToolTime does
not provide a backup function, we strongly recommend you purchase a
suitable backup device such as a tape backup unit, or one of the many
popular high-capacity removable disks.
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Contacting Support

How To Get In Touch With Us
Dixon Creek Software's regular office hours are Monday through Friday
8:30am to 5:00pm Pacific Time.  We can be reached in the following
manners:

Toll-free: (888) 349-6627

Oregon: (541) 752-3051

Fax: (541) 752-6804

E-mail: fms@dixoncreek.com

Mailing Address: PMB 200

2397 NW Kings Blvd.

Corvallis, OR 97330

ToolTime Support Program
From time to time problems come up that require assistance from our
technical staff. We at Dixon creek Software strive to provide the highest
quality user support available.  We are always more than happy to supply
you with helpful, friendly and courteous answers to all your computer
questions.

The purchase of your ToolTime product entitles you to one full year of free
technical support as well as all maintenance updates during that period of
time.  You will also receive special notification of new ToolTime products
and upgrades as they become available.  Additional annual support
agreements may be purchased from Dixon Creek Software and will provide
the same technical support, maintenance updates and services received
during the first year.
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How to Use Help

Online Help
The Demonstration Version of ToolTime also provides the full manual text
as an online help facility.  You can access that information from the Help
menu on the Main Screen or by pressing F1 at any time.

To view the information on how to use the help file, run ToolTime and from
the Help menu on the Main Screen choose Contents.  After the help file
loads, click the Help menu there and from the list choose How to Use Help.
Information can also be obtained from your Windows documentation.
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